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1. WYMOGI BEZPIECZEŃSTWA 
 

Poniższe wymogi bezpieczeństwa nie zawierają wszystkich informacji dotyczących działania 

urządzenia. Należy się zapoznać z niniejszą instrukcją obsługi w całości! 

 

UWAGA: Wszelkich podłączeń i zmian należy dokonywać przy odłączonym napięciu 

sieciowym i zasilającym. 

 

UWAGA:  Instalacja oraz programowanie urządzenia wymagają posiadania odpowiednich 

umiejętności, dlatego mogą być dokonywane tylko przez wykwalifikowany 

personel po zapoznaniu się w całości z instrukcją obsługi. 

 

UWAGA:  Urządzenie musi być instalowane w dodatkowej skrzynce przeznaczonej do 

urządzeń elektrycznych. Musi ona chronić urządzenie przed dostępem osób 

niepowołanych a w szczególności dzieci. Skrzynka musi również chronić 
urządzenie przed pyłem, wilgocią oraz innymi czynnikami mogącymi spowodować 
jego uszkodzenie. Skrzynka musi zapewnić odpowiednią temperaturę pracy 

urządzenia. 

 

UWAGA:  W przypadku, gdy urządzenie ulegnie uszkodzeniu należy skontaktować się ze 

sprzedawcą lub instalatorem.  

 

UWAGA: Wewnętrzne elementy urządzenia oraz jego obudowa mogą być gorące w trakcie 

działania oraz pozostać gorące nawet po odłączeniu zasilania. 

 

UWAGA:  Należy się upewnić czy zainstalowano odpowiednie zabezpieczenie na przewodach 

zasilających urządzenie, aby zapobiec jego uszkodzeniu. 

 

UWAGA:  Nieprawidłowo podłączone urządzenie może ulec uszkodzeniu. 

 

UWAGA:  Odpowiedzialność za prawidłową instalację urządzenia spoczywa na osobie 

montującej. Należy się upewnić czy spełnione zostają wszystkie wytyczne i normy 

obowiązujące w danym kraju.  

 

UWAGA: Wyładowania elektrostatyczne mogą uszkodzić urządzenie. Należy stosować 
odpowiednie zabezpieczenia. 

 

UWAGA: Wszelkie nieautoryzowane przeróbki, modyfikacje oraz próby naprawy powodują 
utratę gwarancji.  
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2. Wstęp 

 
Moduł 16 wyjść cyfrowych MWY-16 wyposażony jest w 16 bezpotencjałowych wyjść 

przekaźnikowych i służy do niezależnego sterowania 16 urządzeniami wyjściowymi. Mogą to być 

np. zawory do kaloryferów zasilane napięciem 24VDC, styczniki jedno- lub trójfazowe, przekaźniki 

itp. Typowo urządzenie przewidziane jest do zastosowania w instalacjach inteligentnych budynków, 

gdzie określona ilość modułów wyjściowych odpowiada za pełne sterowanie urządzeniami 

budynku. Moduł sterowany jest przez interfejs Modbus, który jest standardem przemysłowym w 

dziedzinie automatyki. Pełna dokumentacja protokołu jest jawna i łatwo dostępna 

(http://www.modbus-ida.org/), dzięki czemu elementy wykorzystujące interfejs Modbus można 

zastosować w każdym systemie, który obsługuje ten protokół.  Maksymalna obciążalność jednego 

wyjścia wynosi 1A/30VDC. Urządzenie może być zasilane napięciem od 20 do 30V prądu stałego, 

wymaga do 200 mA prądu przy wszystkich wyjściach aktywnych.  

 

 
 

Rys. 1. Widok modułu wyjść cyfrowych MWY-16 

 

 

 

 

3. Dane Techniczne 

 
Tabela 1. Rekomendowane warunki pracy 

Nazwa parametru Wartość 

Max napięcie wyjść 36V 

Prąd przekaźnika max. 1A 

Napięcie zasilania 24VDC 20-30 VDC 

Prąd zasilania 24VDC max. 200mA 

Temperatura pracy 0 – 70
o
C 

Wilgotność
(1) 

5 – 95% 

Wysokość 0 – 2000 m n.p.m. 

Notka 1: Wilgotność bez kondensacji! 
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4. Instalacja. 

 

4.1. Podłączenie obwodu elektrycznego. 

4.1.1 Rozmieszczenie konektorów modułu wyjść. 
 

 
Rys. 2. Rozmieszczenie konektorów modułu wyjść 

 

Opis konektorów: 

 
J200 :   Złącze wyjściowe 

J201:   Złącze komunikacyjno-wyjściowe  

J300:   Złącze zasilające 

SW100:  Przełącznik adresu, prędkości transmisji danych i trybu Modbusa modułu wyjść 

 

Uwaga: Podłączanie niezgodne z instrukcją może spowodować nieprawidłową pracę i/lub 

uszkodzenie urządzenia nie objęte gwarancją! 
 

4.1.2. Schemat wewnętrzny 1 wyjścia.  

 

 
Rys. 3. Schemat wewnętrzny 1 wyjścia. 
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4.1.3 Złącze wyjściowe J200 
 

 
 

Rys. 4. Widok konektora wyjściowego J200.  

 

 

Tabela 2. Opis wyprowadzeń na złączu J200: 

 

Numer  

wyprowadzenia 
Funkcja 

1 OUT0A 

2 OUT0B 

3 OUT1A 

4 OUT1B 

5 OUT2A 

6 OUT2B 

7 OUT3A 

8 OUT3B 
 

Numer  

wyprowadzenia 
Funkcja 

9 OUT4A 

10 OUT4B 

11 OUT5A 

12 OUT5B 

13 OUT6A 

14 OUT6B 

15 OUT7A 

16 OUT7B 
 

Numer  

wyprowadzenia 
Funkcja 

17 OUT8A 

18 OUT8B 

19 OUT9A 

20 OUT9B 

21 OUT10A 

22 OUT10B 

23 OUT11A 

24 OUT11B 
 

 

 

4.1.4 Złącze komunikacyjno-wyjściowe J201 modułu wyjść MWY-16 

 

 
Rys. 5. Widok konektora komunikacyjno-wyjściowego J201 
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Tabela 3. Opis wyprowadzeń na złączu J201: 

Numer 

wyprowadzenia 
Funkcja 

1  D- 

2  D+ 

3  OUT12A 

4  OUT12B 

5  OUT13A 

6  OUT13B 

7  OUT14A 

8  OUT14B 

9  OUT15A 

10  OUT15B 

 

 

4.1.5 J300 - złącze zasilania modułu wyjść MWY-16 
 

 
Rys. 6. Widok złącza zasilającego J300 modułu MWY-16 

 

Tabela 4. Opis wyprowadzeń na złączu J300: 

Numer wyprowadzenia Funkcja 

1 +24VDC 

2 GND (masa zasilania 24VDC) 
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4.1.6 Przykład typowego podłączenia. 
 

Na rysunku 7 pokazano przykład typowego podłączenia modułu wyjść do sterownika PLC firmy 

Fatek przy pomocy interfejsu RS485. 
 

 
 

Rys. 7. Przykład typowego podłączenia modułu wyjść do sterownika PLC FATEK 
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4.2 Instalacja mechaniczna, wymiary, mocowanie do szyny DIN 35 mm 
 

Na rysunku 8 pokazano wymiary obudowy modułu wyjść. Obudowa jest przystosowana do 

montażu na szynie DIN 35mm. 

 

 
 

Rys. 8. Wymiary obudowy modułu wyjść MWY-16 

 

 

5. Konfiguracja 
 

5.1. Działanie urządzenia 
 

W momencie włączenia urządzenia CPU wykonuje test urządzenia, a także odczytuje parametry 

konfiguracyjne – ustawiony adres, prędkość komunikacji oraz tryb – RTU lub ASCII. Po około 1s 

od włączenia zasilania urządzenie jest gotowe do pracy. 

 

Lista adresów Modbus modułu wyjść: 

 

Tabela 5. Cewki 

Adres cewki Numer wyjścia 

1000 OUT0 

1001 OUT1 

1002 OUT2 

1003 OUT3 

1004 OUT4 

1005 OUT5 

1006 OUT6 

1007 OUT7 

1008 OUT8 

1009 OUT9 

1010 OUT10 

1011 OUT11 
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1012 OUT12 

1013 OUT13 

1014 OUT14 

1015 OUT15 

 

   Tabela 6. Input Registers (3x) 

Adres rejestru Opis 

1100 Identyfikacja 

1101 
Wersja 

oprogramowania 

 

   Tabela 7. Holding Registers (4x) 

Adres rejestru Opis 

1200 Stan wyjść 

1201 Sterowanie 
 

 

5.2.  Opis sterowania za pomocą interfejsu Modbus: 
 

Moduł wyjść posiada możliwość autodetekcji za pomocą rejestru 1100, zaimplementowanego jako 

Input Register (read-only/tylko do odczytu). Znajduje się w nim wartość 124 identyfikująca 

urządzenie jako moduł MWY-16. Rejestr 1101 służy do identyfikacji wersji oprogramowania 

znajdującej się w module. Wartość 101 oznacza wersję oprogramowania 1.0.1. 

 

Sposób sterowania wyjściami zależy od wartości rejestru 1201.  

 

1. Gdy rejestr 1201 przyjmie wartość 0, to steruje się maską bitową ustawioną 

w rejestrze 1200, a stan wyjść ustawiony na cewkach jest ignorowany.  

W rejestrze 1200 (zaimplementowanym jako Holding Register) każdy bit odpowiada 

jednemu wyjściu.  
 

Przykład: 
 

0000'0000'0000'0000 – wszystkie wyjścia nieaktywne 

0000'0000'0000'0001 – wyjście 0 aktywne 

0000'0000'0000'0010 – wyjście 1 aktywne 

0000'0000'0000'0100 – wyjście 2 aktywne 

0000'0000'0000'1000 – wyjście 3 aktywne 

0000'0000'0001'0000 – wyjście 4 aktywne 

0000'0000'0010'0000 – wyjście 5 aktywne 

0000'0000'0100'0000 – wyjście 6 aktywne 

0000'0000'1000'0000 – wyjście 7 aktywne 

0000'0001'0000'0000 – wyjście 8 aktywne 

0000'0010'0000'0000 – wyjście 9 aktywne 

0000'0100'0000'0000 – wyjście 10 aktywne 

0000'1000'0000'0000 – wyjście 11 aktywne 

0001'0000'0000'0000 – wyjście 12 aktywne 

0010'0000'0000'0000 – wyjście 13 aktywne 

0100'0000'0000'0000 – wyjście 14 aktywne 

1000'0000'0000'0000 – wyjście 15 aktywne 

1111'1111'1111'1111 – wszystkie wyjścia aktywne 
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2. Gdy rejestr 1201 przyjmie wartość 1, steruje się cewkami, a stan wyjść ustawiony na 

rejestrze 1200 jest ignorowany. Każda cewka odpowiada jednemu wyjściu. Jeśli 

cewka jest włączona, wyjście jest aktywne. Jeśli cewka jest wyłączona, wyjście jest 

nieaktywne. 

 

5.3. Diody sygnalizacyjne.  
 

5.3.1. Diody sygnalizacyjne modułu wyjść MWY-16. 
 

Diody sygnalizacyjne znajdują się na płytce drukowanej modułu, wewnątrz obudowy modułu wyjść 

MWY-16. 

 

 
 

Rys. 9. Diody sygnalizacyjne modułu wyjść MWY-16. 

 

Opis diod modułu wyjść: 
 
D0..D15: Diody sygnalizacyjne wyjść 

Dioda świeci – wyjście aktywne 

Dioda nie świeci – wyjście nieaktywne 

 
D16: Odbiór RS-485: miganie kontrolki oznacza odbieranie danych po RS-485, 

D17: Nadawanie RS-485, miganie kontrolki oznacza wysyłanie danych po RS-485, 

D18: Zasilanie CPU: zapalona oznacza obecność napięcia zasilającego CPU. 

D19: Kontrolka CPU, miganie oznacza poprawną pracę CPU, 

D20: Kontrola kierunku transmisji RS-485: dioda zapalona oznacza kierunek transmisji ustawiony 

na odbieranie, dioda zgaszona oznacza kierunek transmisji ustawiony na nadawanie. 

 

Nieprzerwane świecenie się obu diod (TX, RX), lub tylko jednej (RX lub TX) sygnalizuje 

możliwość błędu w podłączeniu przewodów sygnałowych do gniazda komunikacyjnego (J201) lub 

błędnego ustawienia adresu modułu wyjść. Miganie tylko diody sygnalizującej odbieranie danych 

przez moduł wyjść sygnalizuje możliwość ustawienia błędnego adresu lub wybranie błędnych 

parametrów transmisji (nieprawidłowa prędkość, ustawienia parzystości, liczba bitów stopu, trybu 

Modbus RTU/ASCII itp.). 
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5.4. Zworki konfiguracyjne. 

 

5.4.1. Ustawianie adresu Modbus za pomocą switcha SW100 

 

 
 

Rys. 10. Switch SW100 do ustawiania adresu Modbus (zworki 1-6) 

Na rysunku przedstawiono 31 z 63 możliwych ustawień adresu. 

 

 

W położeniu przedstawionym na rysunku, zworka w pozycji OFF oznacza 1, w pozycji ON – 0.  

 

W switchu SW100 zworki 1..6 służą do ustawienia adresu w protokole Modbus: 

1 – A0 (najmniej znaczący bit adresu - LSB), 

2 – A1, 

3 – A2, 

4 – A3, 

5 – A4, 

6 – A5 (najbardziej znaczący bit adresu – MSB). 

 

Adres modułu wyjść w protokole Modbus: 

- ustala się sprzętowo za pomocą switcha SW100,  

- może przyjmować wartości 1..63,  

- adres 0 jest zarezerwowany w specyfikacji protokołu Modbus jako rozgłoszeniowy (broadcast),  

- ustawia się w postaci binarnej, tzn. 27 (dec) = 011011 (bin). Switch w pozycji ON to bit adresu 

ustawiony jako 0. Switch w pozycji OFF to bit adresu ustawiony jako 1.  
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Uwaga: Aby zmienić adres modułu w protokole Modbus, prędkość transmisji lub tryb 

RTU/ASCII, należy ustawić żądane parametry, a następnie wyłączyć i włączyć zasilanie. 

Zmiana parametrów przy włączonym zasilaniu nie odniesie skutku. Nastąpi to dopiero przy 

ponownym uruchomieniu urządzenia. 
 

5.4.2. Ustawianie prędkości transmisji za pomocą switcha SW100. 
 

Zworka 8 ze switcha SW100 służy do ustawiania prędkości transmisji: 

ON – prędkość 9600 bps 

OFF – prędkość 57600 bps 

 

5.4.3. Ustawianie trybu Modbus (RTU/ASCII) za pomocą switcha SW100. 
 

Zworka 7 ze switcha SW100 służy do ustawiania typu Modbus: 

ON – RTU 

OFF – ASCII 

 

Uwaga: W module wyjść i urządzeniu nim sterującym muszą być ustawione takie same 

parametry transmisji! 

 

5.5. Protokół transmisji danych 

 
Moduł wyjść komunikuje się z urządzeniem sterującym za pomocą protokołu Modbus. W warstwie 

fizycznej połączenie jest realizowane za pomocą dwuprzewodowego interfejsu RS-485 z transmisją 

half-duplex.  

 

Parametry transmisji (Modbus RTU): 

 

Modbus: RTU 

prędkość: przełączana zworką 

9600/57600 bps 

parzystość: even 

ilość bitów danych: 8 

ilość bitów stopu: 1 

 

 

Parametry transmisji (Modbus ASCII): 

 

Modbus: ASCII 

prędkość: przełączana zworką 

9600/57600 bps 

parzystość: even 

ilość bitów danych: 7 

ilość bitów stopu: 1 

 

 

Magistrala RS-485 powinna być wykonana z 2 skręconych ze sobą przewodów.  

 

Uwaga: W module wyjść i urządzeniu nim sterującym muszą być ustawione takie same 

parametry transmisji! 

5.6. Przykład podłączenia modułu wyjść do sterownika PLC Fatek 
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Aby nawiązać komunikację ze modułem wyjść poprzez magistralę RS-485, należy najpierw 

skonfigurować port w sterowniku PLC. Możemy tego dokonać za pomocą programu  

WinProLadder. Wybieramy z menu: PLC → Setting → Port (numer portu, po którym będzie 

odbywała się komunikacja). Musi to być port, do którego przyłączona jest magistrala łącząca PLC 

z modułem wyjść.  

 
 

Rys. 11. Wybór portu komunikacyjnego w programie WinProLadder 

 

Po wybraniu odpowiedniego portu musimy go skonfigurować. Ustawiamy następujące parametry 

transmisji w trybie RTU: 

− prędkość (Baud Rate):    9600 (lub 57600) bps 

− parzystość: (Parity)    even 

− ilość bitów danych (Data Bit):   8 

− ilość bitów stopu (Stop Bit):   1 

− protokół:     Modbus RTU (slave) 

 

 
Rys. 12. Konfiguracja portu komunikacyjnego sterownika PLC, w trybie RTU. 

 

Po wybraniu odpowiedniego portu musimy go skonfigurować. Ustawiamy parametry transmisji 

w trybie ASCII: 



 

 15 

 

− prędkość (Baud Rate):    9600 (lub 57600) 

− parzystość (Parity):     even 

− ilość bitów danych (Data Bit):   7 

− ilość bitów stopu (Stop Bit):   1 

− protokół:      Modbus ASCII (slave) 

 

 
 

Rys. 13.  Konfiguracja portu komunikacyjnego sterownika PLC, w trybie ASCII 

 

 

Uwaga: W module muszą ą ą ą być ć ć ć ustawione takie same parametry transmisji, jak w porcie 

sterownika, do którego jest podłąąąączony! Nie oznacza to, żżżże we wszystkich portach sterownika 

musi być ć ć ć ustawiona taka pręęęędkość ść ść ść transmisji co w porcie do modułu. 

 
 

Sterownik używany jako „master” musi mieć uruchomioną funkcję 150.M_BUS. W funkcji 

150.M_BUS (150) użytkownik ustawia tylko ten port, którego będzie używał do komunikacji, 

rejestr startowy programu do komunikacji oraz rejestr roboczy (rys. 14).  
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Funkcja 150.M_BUS 

 
 

Rys. 14. Blok funkcyjny do obsługi komunikacji przy użyciu  

protokołu Modbus (funkcja: 150.M_BUS). 

 

Pt:   Numer portu w PLC, który ma być użyty do komunikacji, 

SR:   Rejestr startowy,  

WR:   Rejestr roboczy.  

 

Jeżeli wejście A/R = 0  - protokół Modbus RTU (domyślnie – wtedy, kiedy A/R nie jest podłączone) 

Jeżeli wejście A/R = 1 - protokół Modbus ASCII  

 

Jeżeli stan wejścia ABT zmieni się na 1, transmisja zostaje przerwana, a po jej wznowieniu 

przesyłanie zaczyna się od pierwszego pakietu danych. Wyjścia ACT, ERR, DN sygnalizują 

odpowiednio: transmisję w toku, błąd transmisji i pomyślne zakończenie transmisji. Mogą one być 

wykorzystywane do testowania i debuggowania połączenia, ale użycie ich nie jest wymagane. 

Kiedy port jest już skonfigurowany, wstawiamy znacznik M192x, który będzie odpowiadał za 

częstotliwość wysyłania pakietów danych po Modbusie. 

 

M1920: 10ms 

M1921: 100ms 

M1922: 1s.  

 

Następnie wstawiamy funkcję 150.M_BUS. Kiedy już zostanie skonfigurowany port oraz 

wstawiona funkcja 150.M_BUS,  musimy stworzyć tabelę. Z menu wybieramy: Project → ModBus 

Master Table → Add ModBus Master Table (rysunek 15 i 16). 

 

 
 

Rys. 15. Widok ekranu przy wstawianiu z menu tabeli  

do obsługi protokołu Modbus. 
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Rys. 16. Widok ekranu przy wstawianiu z drzewa konfiguracji tabeli  

do obsługi protokołu Modbus. 

 

 

Po wybraniu Add ModBus Master Table pojawi się okno Table Edit (rys. 17).  

 

 
 

Rys. 17. Okno konfiguracji funkcji Modbus w sterowniku FATEK. 

 

 

W polu Table Name użytkownik może wpisać dowolną nazwę np. Modbus, natomiast w polu Table 

Starting Address należy wpisać rejestr startowy, który został użyty w programie w funkcji 

150.M_BUS, np.: R1000. Następnie po pojawieniu się okna Modbus Master Table można dodawać 

komendy (rys. 18).  
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Rys. 18. Okno edycji komend. 

 

 

Po naciśnięciu przycisku Add pojawia się okienko Command Item, w którym należy wprowadzić 

numer stacji Slave Station (adres modułu wyjść). Następnie należy wybrać rodzaj komendy 

(Read/Write), rozmiar przesyłanych danych, adres startowy w sterowniku „master” oraz adres 

startowy w module wyjść (lub innym urządzeniu) „slave”.  

 

Przykładowa konfiguracja: 

 

Slave Station:   3 (adres fizyczny modułu wyjść równy 3) 

Command:    Write (Zapis) 

Data Size:   1  

Master Data Start Address: np. R400 (wysyła na wyjście stan maskę bitową z R400) 

Slave Data Start Address: 401200  

Master Data Start Address:  Początek tabeli danych w PLC 

Slave Data Start Address:  Początek tabeli danych w module wyjść 

 

Slave Station:   3 (adres fizyczny modułu wyjść równy 3) 

Command:    Write (Zapis) 

Data Size:   1  

Master Data Start Address: np. R401 (wybieramy sterowanie cewkami lub maską bitową) 

Slave Data Start Address: 401201  

Master Data Start Address:  Początek tabeli danych w PLC 

Slave Data Start Address:  Początek tabeli danych w module wyjść 

 

Do celów testowych musimy teraz dodać nową StatusPage, aby móc sterować modułem wyjść 

poprzez sterownik PLC (rys. 19).  
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Rys. 19 Dodawanie nowej StatusPage w programie WinProLadder 

 

Dodajemy teraz podgląd rejestrów (R400 – stan wyjść i R401 -  wybór sposobu sterowania) 

(rys.20). 

 
 

Rys. 20 Dodawanie podglądu rejestrów 

 

Aby było wygodniej sterować możemy zmienić widok R400 na typ binarny (wtedy każdy bit 

odpowiada jednemu wyjściu) (rys. 21).  
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Rys. 21 Zmiana typu widoku R400 na binarny 

 

Teraz, gdy ustawimy rejestr R400 na wartość 1010101010101010B (rys. 22), zostanie włączone co 

drugie wyjście modułu. 

 

 
 

Rys. 22 Ustawianie wartości rejestru R400, w postaci binarnej 

 

Modułem możemy też sterować za pomocą cewek. W tym celu należy dodać do tabeli Modbus 

nową komendę.  

 

Slave Station:   3 (adres fizyczny modułu wyjść równy 3) 

Command:    Write (Zapis) 

Data Size:   16  

Master Data Start Address: M100 (Cewka startowa to znacznik M100) 
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Slave Data Start Address: 001000 (adres startowy cewek w module) 

Master Data Start Address:  Początek tabeli danych w PLC 

Slave Data Start Address:  Początek tabeli danych w module wyjść 

 

 
 

Rys. 23 Dodawanie nowej komendy w tabeli Modbus. 

 

 

Następnie, aby móc sterować wyjściami poprzez StatusPage, należy je tam dodać (rys. 24).  

 

 

 
 

Rys. 24 Dodanie znaczników M100-M115 w celu sterowania wyjściami 
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Należy teraz zmienić sposób sterowania z maski bitowej w rejestrze R400, na sterowanie cewkami 

M100-M115. Robimy to przez zmianę wartości w rejestrze R401 z 0 na 1. Możemy teraz sterować 

wyjściami poprzez stan bitów M100-M115 w sterowniku. Gdy bit ma stan 0, wyjście jest 

nieaktywne, a gdy stan jest równy 1, wyjście jest aktywne (rys. 25). 

 

 
 

Rys. 25 Zmiana wartości w rejestrach w celu sterowania cewkami. 
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6. Przykład konfiguracji z panelem HMI  

 
Podłączamy panel HMI z urządzeniem wg następującego schematu (rys.26): 

 

 
 

Rys. 26. Schemat podłączenia panelu HMI firmy Weintek do modułu wyjść. 

 

 

Aby moduł wyjść współpracował z panelem HMI, należy odpowiednio skonfigurować panel 

w programie EasyBuilder. 

 

Konfigurujemy następujące parametry urządzenia i panelu (Menu: Edit → System Parameters) 

(rys. 27):  
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Rys. 27 Konfiguracja parametrów urządzenia i panelu 

 

Przykładowa konfiguracja: 

PLC type: MODBUS RTU (RS-485 2W)  

HMI model:  MT505T (model panelu HMI, który konfigurujemy) 

PLC I/F port:   RS-485 2W (port, którym łączymy się z panelem HMI) 

Baud rate:  9600 bps 

Parity:  Even 

 

Na ekranie pojawia się wirtualny panel HMI, na którym możemy dodawać potrzebne elementy do 

sterowania modułem wyjść. Do sterowania parametrami modułu wyjść można użyć przycisku do 

wpisywania liczb z klawiatury ekranowej (Numeric Input Extend) (rys. 28).  

 

 
 

Rys. 28. Dodawanie przycisku do wpisywania wartości liczbowej w panelu HMI Weintek. 
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W oknie konfiguracyjnym podajemy następujące dane (rys. 29): 

 

 
 

Rys. 29. Okno konfiguracji przycisku do wpisywania wartości liczbowej w panelu HMI Weintek. 

 

 

Description:   Nazwa identyfikacyjna określonej klawiatury 

Device type:   4x (dla 16-bitowych Holding Registers 4x) 

Device address 1200 (podajemy tylko ostatnie 4 cyfry 1200, 1201, 1202 itd.) 

Trigger address:  LB 9000 (W przypadku niektórych typów paneli, aby zadziałała 

klawiatura ekranowa, musi być ustawiony dowolny bit. Aby uniknąć 

dodawania niepotrzebnych przycisków, można wykorzystać bit LB 

9000, który jest ustawiony na stałe). 

Kolejnymi modułami wyjść sterujemy tak samo. Kolejne klawiatury ekranowe konfigurujemy 

analogicznie jak w przykładzie powyżej, pamiętając jedynie o tym, by ustawiać odpowiednie adresy 

modułu wyjść. Następnie zapisujemy program, kompilujemy i wysyłamy do panelu: 

 

 
 

Rys. 30 Przycisk Download do kompilacji i wysyłania programu do panelu. 

 

Po poprawnym podłączeniu panel będzie sterować modułem wyjść w pełni samodzielnie. 
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7. Uwagi końcowe 
 

1.  Producent zastrzega sobie prawo do wprowadzania ciągłych poprawek i ulepszeń. 

2.  Produkt może nieznacznie różnić się od fotografii. 

3.  Instrukcja może zawierać błędy. Producent nie odpowiada za jakiekolwiek uszkodzenia, które 

z nich mogą wyniknąć. Jednocześnie producent oświadcza, że dołoży wszelkich starań by żadne 

błędy w instrukcji się nie pojawiły, a jeżeli tak się stanie, to informacje o wszelkich błędach 

zamieści na swojej stronie internetowej.  

4.  Producent nie odpowiada za żadne szkody wynikające z użytkowania urządzenia. 

5.  Aktualna wersja instrukcji znajduje się na stronie www.esea.pl. 

6.  Wszelkie uwagi dotyczące urządzenia oraz tej instrukcji proszę kierować na email: 

info@esea.pl.    

 

 

 

 


